May 04, 2016

Trademarks: NewTek, TriCaster, TriCaster Advanced Edition, TriCaster XD, TriCaster 8000, TriCaster TCXD8000, TCXD8000, TriCaster 860, TriCaster TCXD860, TCXD860, TriCaster 460, TriCaster TCXD460, TCXD460, TriCaster 410, TriCaster TCXD410, TCXD410, TriCaster Mini SDI, TriCaster Mini, TriCaster 40, TriCaster TCXD40, TCXD40, TriCaster 855, TriCaster, TCXD855, TCXD855, TriCaster 455, TriCaster TCXD455, TCXD455, TriCaster EXTREME, TriCaster 850 EXTREME, TriCaster TCXD850 EXTREME, TCXD850 EXTREME, TriCaster 450, EXTREME, TriCaster TCXD450 EXTREME, TCXD450 EXTREME, TriCaster 850, TriCaster, TCXD850, TCXD850, TriCaster 450, TriCaster TCXD450, TCXD450, TriCaster 300, TriCaster, TCXD300, TCXD300, TriCaster PRO, TriCaster STUDIO, TriCaster BROADCAST, TriCaster, DUO, 3PLAY, 3Play, 3Play 4800, 3PXD4800, 3Play 440, 3PXD440, 3Play Mini, 3Play 820, 3PXD820, 3Play 425, 3PXD425 3Play 330, 3PXD330, TalkShow, TalkShow VS100, Network Device Interface, NDI, ProTek, ProTek Care, ProTek Elite, iVGA, SpeedEDIT, IsoCorder, LiveText, DataLink, LiveSet, TriCaster Virtual Set Editor, Virtual Set Editor Advanced Edition, TriCaster VSE, TriCaster VSE Advanced Edition, LiveMatte, TimeWarp, VT, VT[3], VT[4], VT[5], Video Toaster, Toaster, Inspire 3D, 3D Arsenal, Aura, LightWave, LightWave 3D and LightWave CORE are trademarks, service marks, and registered trademarks of NewTek. All other brand names, product names, or trademarks belong to their respective holders.
# TABLE OF CONTENTS

**ABOUT THIS MANUAL** ...................................................................................................................... 5

**CHAPTER 1 INSTALLATION AND ACTIVATION** .................................................................................. 7

  **SECTION 1.1 WELCOME** .................................................................................................................. 7
  **SECTION 1.2 SYSTEM REQUIREMENTS** .......................................................................................... 7
  **SECTION 1.3 INSTALLATION** ........................................................................................................... 8
    1.3.1 GETTING READY ......................................................................................................................... 8
    1.3.2 INSTALLATION STEPS .............................................................................................................. 8
    1.3.3 VIRTUAL SET EDITOR LAUNCH ................................................................................................. 10
    1.3.4 REGISTRATION ......................................................................................................................... 10

**CHAPTER 2 VSE WALKTHROUGH** .................................................................................................... 13

  **SECTION 2.1 FIRST STEPS** ............................................................................................................ 13
  **SECTION 2.2 THE STARTUP WIZARD** ............................................................................................ 13
  **SECTION 2.3 VSE DESKTOP TOUR** ................................................................................................ 14

**CHAPTER 3 FEATURES AND CONTROLS** .......................................................................................... 25

  **SECTION 3.1 STARTUP WIZARD** .................................................................................................... 25
  **SECTION 3.2 MENUS** ...................................................................................................................... 26
    3.2.1 FILE........................................................................................................................................ 26
    3.2.2 VIEW ..................................................................................................................................... 28
    3.2.3 HELP ..................................................................................................................................... 28
  **SECTION 3.3 ANGLE BIN** ............................................................................................................... 28
  **SECTION 3.4 CONTROL STACK** ..................................................................................................... 29
    3.4.1 ITEM HEADERS......................................................................................................................... 29
    3.4.2 POSITION, SCALE, AND ROTATION ......................................................................................... 30
    3.4.3 PROC AMP .............................................................................................................................. 31
    3.4.4 STYLE .................................................................................................................................... 32
  **SECTION 3.5 ANIMATION CONTROLS** ........................................................................................... 32
  **SECTION 3.6 VIRTUAL SET CANVAS** .............................................................................................. 32
  **SECTION 3.7 IMPORTING PHOTOSHOP® FILES** ............................................................................. 33
    3.7.1 FILE REQUIREMENTS............................................................................................................... 34
    3.7.2 INPUT LAYERS ......................................................................................................................... 34
  **SECTION 3.8 HOLOGRAPHIC LIVESETS** ........................................................................................ 38
    3.8.1 PANORAMIC BACKGROUND IMAGES ...................................................................................... 39
  **SECTION 3.9 FLARES** ..................................................................................................................... 41
A  HOW DO I ... ? ................................................................................................................. 47
A.1  VIRTUAL SETS ................................................................................................................. 47
A.1.1  ADD MORE VIRTUAL SET PRESETS? ............................................................................. 47
A.1.2  CREATE A COMPLETELY CUSTOM VIRTUAL SET? .................................................... 47
A.2  FILE MANAGEMENT ........................................................................................................... 48
A.2.1  LOCATE MY NEW VIRTUAL SETS IN THE LIVE PRODUCTION SUITE’S LIVE DESKTOP? .................................................................................................................. 48
A.2.2  ORGANIZE VIRTUAL SETS IN CUSTOM LOCATIONS? .................................................. 48
A.2.3  USE THE ADVANCED EDITION STYLE “BASIC/STANDARD” FILE NAMING SCHEME? ................................................................................................................................. 48
A.2.4  DELETE UNWANTED VIRTUAL SETS FROM THE LIVE PRODUCTION SUITE? ............... 49

B  KEYSTROKE SHORTCUTS ........................................................................................................ 51
B.1  MENU OPERATIONS .......................................................................................................... 51
B.2  VIRTUAL SET CANVAS ....................................................................................................... 51
B.3  CONTROL STACK .............................................................................................................. 51
B.4  ANIMATION CONTROL ...................................................................................................... 51

C  INDEX .................................................................................................................................... 53
CREDITS ....................................................................................................................................... 54
PART I (GETTING STARTED)

Introducing Virtual Set Editor – installation and registration, a top-level overview of primary features, and a hands-on tour to get you started.
ABOUT THIS MANUAL

Virtual Set Editor provides new and important capabilities, and is available as a standalone application for use on an external workstation or even a laptop.

This manual provides basic information you need to begin working with Virtual Set Editor in the introductory Walkthrough section, and goes on to provide a comprehensive reference section you can turn to when you need finer detail.

Please take a moment to peruse this section, which explains the manual’s organization.

Part I – Getting Started: An introduction to Virtual Set Editor – a brisk jog through fundamentals, including installation and registration, along with a feature walkthrough. If you’re a quick study, Getting Started may provide all you really need.

Part II – Reference: This section covers the finer details of Virtual Set Editor – for those who need it, and those who just like to know everything.

Part III – Appendices: Appendix B lists all shortcut keys. Part III is also home to a question and answer section (“How Do I … ?”) and comprehensive keyword index.
CHAPTER 1 INSTALLATION AND ACTIVATION

This chapter explains how to properly install your new software, whether for integration and use within a NewTek live production suite or for standalone operation.

It also reviews registration for warranty, updates and technical support, and product activation. After completing this short section, you’ll be all set to continue into the Walkthrough chapter that follows it.

SECTION 1.1 WELCOME

NewTek’s live production suite comes with ‘network-class’ virtual sets developed using proprietary NewTek LiveSet™ technology. Virtual Set Editor (VSE) enables live production suite users to customize included high definition (HD) live virtual sets, and can also be used for compiling original LiveSets on suitable standalone systems.

Decorate virtual sets with custom logos, modify color schemes, furniture options, create custom start and end points for zooms, adjust placement and scale for video inputs, and even create brand new sets from custom graphics files.

Controls such as position, scale, rotation, color correction (brightness, hue, contrast and saturation), and the Media Browser will be immediately familiar to live production suite users.

Once a virtual set has been customized, you can easily export it for immediate use in live production. NewTek Virtual Set Editor permits schools, broadcasters and independent producers to personalize their productions – easily and affordably.

SECTION 1.2 SYSTEM REQUIREMENTS

VSE can be installed on a on a standalone Windows® workstation, or on any HD-capable NewTek live video production suite.

Hint: You should always check for NewTek live production suite software updates prior to installing new Add-ons.
Standalone system requirements are as follows:

- DirectX 11 NVidia GPU with 1GB graphics memory or better
- 1280x800 display
- 4 GB RAM or better
- 64bit Windows 7® Operating system with Service Pack 1
- 5GB free hard drive space
- CPU supporting AVX instructions

**Important Note:** The VSE installer also includes Animation Store Creator. Live production suites without Animation Store transition support will not list ASC in their Add-Ons links.

### SECTION 1.3 INSTALLATION

To begin, let’s review ‘what came in the box’:

- USB key
- Installation instruction card (insert).

#### 1.3.1 GETTING READY

1. Power up the system you intend to install VSE on (whether a live production suite or suitable Windows PC).
2. For a live production suite setup:
   a. Select the Shut Down icon on the icon ring in the live production suite Startup Screen’s Home page.
   b. Click the Exit to Windows link at right.
   c. Click the Exit to Windows button in the confirmation dialog that opens next.
      (At this point, the live production suite Startup Screen exits, and you are taken to the Microsoft Windows™ Desktop.)
3. Insert the VSE thumb drive into an unused USB port.

#### 1.3.2 INSTALLATION STEPS

**Important Note:** The VSE installer validates system display capabilities. It will decline to install the software when the display hardware of the target system is inadequate.

Power saving modes on some systems may automatically disable more powerful display hardware when the display can run under reduced load, using motherboard graphics chipsets instead. In such cases VSE installation may fail, since the more powerful hardware is not detected. You may be able to adjust the system's graphics card preferences to sidestep this problem,

(For example, for some nVidia GPUs – open the graphics card driver control applet, select "Manage3D settings", and choose “high-performance NVIDIA processor” as the “Preferred Graphics processor”.)
4. Click the Windows Start Menu icon at lower left on the Windows® Desktop, and select the Computer button (to open a system file explorer).

5. Double-click the icon for the VSE USB thumb drive to open a file window.

6. Run the installer application by double-clicking the VSE Setup.exe icon.

(On launch, the installer presents various dialogs to ask you to accept the end user license agreement, and other information as it proceeds.)

7. Click Next in the introductory dialog to begin the installation process (Figure 2).

8. Read the License Agreement in the following dialog, and then select I accept the agreement and click the Next button to continue. If you are installing VSE on a live production suite you can skip to step 11.

9. This next dialog asks where you want to install VSE. Use the defaults and click on Next.

10. Now you can set the destination for the Content Directory. Make note of this location whether you use the default or not. When ready, click Next.

11. The installer will now set up VSE on your system. (Figure 3).
12. A final dialog announces successful completion of the installation process.

13. After installation, the live production suite *Startup Screen* will automatically appear.

14. The icon ring on the *Home* page now displays an *Add-Ons* icon – select this icon, and click the *Virtual Set Editor* link at right (Figure 5).

**STANDALONE**

By default, a VSE icon is shown on the Windows® Desktop after installation.

- Double-click this icon to launch VSE (or use the Windows® Start menu to do so).

15. On first launch (and subsequent launches until registration and activation are complete) the registration dialog is shown (Figure 6).
16. If the host system is connected to Internet, you can click the “Click here ...” button to perform your VSE registration online.

17. Otherwise, note the Product ID shown in this panel, and visit the registration web page (as shown in Step 2) to register your software and receive your unlock code.

18. Click Continue to display the VSE desktop.

Note: Virtual sets can be created before registering and activating VSE, but display a watermark. To remove it, simply re-open the project after activating the software, and then re-save.
This chapter provides a quick hands-on tour of the major components and functions of Virtual Set Editor. In a very short time, its features and their use will be second nature to you.

More detailed reference material on all aspects of VSE follows in Part II (Reference).

Having installed VSE in the previous chapter, we're ready for a little cruise through its highlights.

SECTION 2.1 FIRST STEPS

At the end of Chapter 1, VSE was installed, registered, and activated. Even without those last two steps, you can continue to use VSE throughout the 14 day registration grace period.

Note: Virtual sets created before activation display a watermark. To remove it, simply re-open the project after activating the software, and then re-save.

1. Start by launching the Virtual Set Editor, either from the link displayed at right when you click the Add-Ons icon on live production suite’s Startup page, or using the icon on your Windows® Desktop for standalone installations.

SECTION 2.2 THE Startup WIZARD

The first thing you will see is the Startup Wizard (Figure 7). This convenient panel makes it a breeze to create a new virtual set project, or pick up where you left off on a recent project.

**FIGURE 7**
The Startup Wizard has two bins. The left-hand one is named Open Recent. Eventually, it will display icons for projects you have opened previously. Initially though, it is empty – apart from Browse and Import Photoshop® folder icons (both discussed later).

The right-hand pane is labeled New Project, and shows thumbnail icons for all installed virtual set presets. Each preset contains numerous modifiable and optional elements.

2. Click the icon for the City Loft virtual set preset.

![City Loft virtual set preset](image)

FIGURE 8

A progress gauge is shown as the various elements constituting the selected preset are loaded. In just a few moments, the default City Loft set is shown on the large Virtual Set Canvas that consumes the biggest part of the VSE Desktop (Figure 8).

SECTION 2.3 VSE DESKTOP TOUR

3. Stop and take a look around the VSE Desktop. The dominant feature is the Virtual Set Canvas, which is a large interactive preview pane – but take note, too, of the following additional details:

![Virtual Set Editor](image)

FIGURE 9

4. You will find the File, View and Help menus (Figure 9) at upper-left on the VSE Desktop.
5. The current loaded VSE project is identified at the opposite end of the *titlebar* (Figure 10).

6. Clicking *Exit* (found under *File*) returns you to the *Home* page of live production suite’s *Startup Screen* (or Windows® Desktop), after first prompting you to *Save* your project (when appropriate). In standalone installations, you can also click the [X] found in the upper right corner.

7. Figure 11 shows the *Angles Bin* (displaying the ‘Demo Studio’ project), located in the *VSE Desktop* footer (beneath the large *Virtual Set Canvas*). When a project includes multiple angles (such as *Left*, *Center*, *Right*, and so-on), clicking on an icon in this bin let you select which angle you are working with.

8. The *Presets* control group is located at left in the *Desktop* footer (Figure 12). These controls allow you to set custom *Shot* positions, effectively *LiveSet* zoom/pan presets. (Clicking the thumbnail opens the *Shot* selector.

(Some NewTek live video production suites and standalone installations support 8 shots; other models may show less.)

9. The *Control Stack* (Figure 13) occupies a column on the left side of the *VSE Desktop*. This pane shows a labeled header row for each and every editable item in the currently loaded project.

Every header row, in turn, has a triangular gadget at left, which you can click to expand or collapse the controls for each item.

10. Go ahead and click this triangle in the *Monitor* control header. Observe that the control group expands to reveal a bevy of adjustable settings.
11. Click a *Monitor* expand/contract triangle again to close the group.

![Monitor screenshot](image1)

**FIGURE 14**

12. In fact, let’s remove the virtual monitor from this scene entirely. To do that, click the checkmark at right in the *Monitor* header to remove it (Figure 14).

![Scene modification](image2)

**FIGURE 15**

The monitor vanishes from the scene (as shown by our somewhat ethereal but nonetheless lovely and talented *stand-in*) – see Figure 15.

Let’s make some additional modifications to the scene. There are endless possibilities, but next let’s do something about the placeholder logo on the brick wall, behind our talent stand-in.

![Scene modification](image3)

**FIGURE 16**
13. Turn your attention back to the *Control Stack*, please, and expand the *Wall Logo* control group (Figure 17) by clicking the triangle gadget at left in its header.

**FIGURE 17**

Now, if your client is named “INSERT IMAGE”, you’re finished. Most, however, will prefer to supply a different logo. For demonstration purposes, let’s replace the placeholder image with one of the default images that comes with the live video production suite.

14. Click the drop-down menu labeled *Source* in the *Wall Logo* control group, and select *Browse*. This opens the familiar NewTek *Media Browser* (Figure 18).

**FIGURE 18**
15. Select the *NewTek* entry shown beneath the header *Stills* in the Locations column at left.

16. In the *File Pane* at right, locate the icon named *NewTek Logo.png*, which you will find in the Logos category; click the OK Button.

![Figure 19](image)

**FIGURE 19**

17. Drag the *Scale* numeric slider for X or Y to around 70% and the result should look much like Figure 20.

![Figure 20](image) ![Figure 21](image)

**FIGURE 20**  **FIGURE 21**

18. Change the *Style* setting to *Ignore Room Lights*, re-select the logo file as *Source*, and observe that shadows no longer appear on the logo - Figure 21. (You may well prefer the natural shading, but we did want to show you what this control does.)

![Figure 22](image)

**FIGURE 22**

Let’s notice another useful VSE attribute – item hinting.
19. Roll your cursor over the *Brick Wall* header in the *Control Stack*. The header brightens even before you click it. Notice, too, that the item that is highlighted in the *Control Stack* is also highlighted in the *Virtual Set Canvas* Figure 22.

Item hinting makes it easy to see what each group in the *Control Stack* affects, making it a breeze to select the correct item for editing.

![Figure 23](image)

**FIGURE 23**

20. Until now, we’ve been viewing the default (first) *Shot* position for this set. Locate the *Animation Controls* group at lower left, just beneath the *Control Stack*. Click the thumbnail icon to reveal the expanded *Shot selector* (Figure 23), and pick a shot to edit.

(Note that the number of thumbnail icons shown in the *Shot selector* depends on the type of system VSE is installed on; more on this in the Reference section of this manual.)

21. Expand the *Background* group now, and (using the same technique as for the logo image), replace the default cityscape image with *Jax Sunset.jpg* file (located in NewTek>Stills).

![Figure 24](image)

**FIGURE 24**

22. That looks great, but we can do a little better yet. Let’s adjust the background image placement slightly. Set *Position X* to -13% and *Position Y* to -35%.

23. We’ll work with *Input A* (the talent input) next. Expand the *Input A* header in the *Control Stack*, and use the *Scale* and *Position* settings to modify the scene roughly as shown in Figure 24.

Having scaled the *Input A* frame to a smaller size, and perhaps more off-center than desirable, we should take steps to ensure that the *Shot* we’re currently editing is framed to produce the desired result.
24. First, to help with placement, click the View menu at left above the Canvas, and turn on the 16:9 Safe Area overlay (Figure 25).

25. To ‘move the world’ left, right or up and down, simply drag the cursor over the Canvas with the left mouse button held down. Using the Safe Area overlay as a reference to center things tastefully.

26. You may feel that the zoom level needs to be tweaked, as well. There are several ways to do this; for now, simply drag up or down on the Canvas with the right mouse button depressed until you’re happy (Figure 26).

27. Click a different thumbnail icon in the shot menu to preview the animated zoom, demonstrating the end result of all your modifications.

We could continue endlessly, but let’s finish up at this juncture by saving our VSE project, and then exporting our newly modified set for direct use in a qualified live production suite.

28. Click the File menu label above the Canvas, and select Save As.
29. Accept the suggested name or supply a new one (such as “City Loft Jax”, without the quotes) in the Save As dialog that appears, and click Ok.

![Export To](image1)

**FIGURE 28**

A brief progress dialog will let you know when saving is complete.

30. Now select **Export to > Live** from the **File** menu (assuming VSE is installed on a live production suite). The exported LiveSet will be listed in the **LiveSet** section of the Live Desktop’s **Media Browser** afterward.

31. Click the **Exit** (found under File).

32. Select **Open** (or **New**) on the icon ring in the live production systems Startup’s **Home** page. Then click **Live** on the **Session** page to launch the **Live Desktop**.

![Media Browser](image2)

**FIGURE 29**

All that remains is to test out your new custom virtual set. You’ll find it listed in the Media Browser’s **File Pane** when you click the new **User** entry listed under the **LiveSets** header at left.
PART II (REFERENCE)

A thorough examination of Virtual Set Editor; every button, menu item, feature and control is considered in this section, so you can take full advantage of your software.
Virtual Set Editor is quite straightforward to use, and this is especially true if you are already familiar with common NewTek live production suite controls and features.

In this chapter, we’ll discuss each area of the application, explaining how the various controls operate and what effect they have, and revealing a few little tricks that you may find helpful along the way.

SECTION 3.1 STARTUP WIZARD

Whenever you launch Virtual Set Editor, the **Startup Wizard** provides convenient and quick options. The **Open Recent** pane at left displays icons for projects you have been working on lately. Initially, the bin is empty. You can use the **Browse** button at the left bottom corner of the dialog to load a project from a different location, or make a selection in the **New Project** icon bin at right.

The **New Project** bin shows all installed **VSE Presets**, and also two special icons:

- Click the icon labeled “From Photoshop” to to **Import** layered Photoshop® files (.PSD), converting them to VSE projects that in turn can be used to generate fully original LiveSets. Helpful details are provided in Section 3.7 of this manual.
- The second icon, “From Panorama”, is also special. Click it to open a file browser, select a suitable ‘panoramic’ image file, and continue to create a **Holographic LiveSet™** – a special and exceptionally powerful virtual set variant discussed in detail in Section 3.8.
- The remaining icons represent supplied VSE presets, ready for immediate customization and LiveSet creation.
Let’s take a closer look at the various components of Virtual Set Editor’s Desktop.

SECTION 3.2 MENUS

3.2.1 FILE

The File menu, important as its functions are, hides no mysterious secrets. Let’s review each entry it offers in turn.
• The New menu item opens an uninitialized project using the Holographic LiveSet canvas. (From here, you can expand the Background group in the Control Stack and browse to a suitable panoramic file using the Source dropdown.)

• Open presents VSE’s Startup Wizard and allows you to open a VSE project in that manner.

• Selecting Recent from the File menu shows a list of the latest projects that you have worked on, making it easy to jump to one of them in its last-saved state.

• Save and Save As are similar and familiar – use the former to save the currently open VSE project file, or the latter to save it under a new name.

• Selecting Export to ... compiles the shots for the current VSE project, and sends them to the proper location for use in the Live Desktop. The process can take some time to complete, and progress gauges are shown.

The export sub-menu displays lists any qualified live production systems on the same network (sub-net) below. The latter feature appears for standalone VSE installations as well, allowing graphics artists to instantly update different live production systems on their local network.

• Create Installer allows you to set and select file attributes and content such as readme files, etc., then asks for an export path, and finally bundles up the LiveSet as an executable installer file for use on a remote live production suite (a great way to distribute custom LiveSets to clients).
Finally, *Exit* closes *VSE*, returning you to the *Startup Screen*.

---

### 3.2.2 VIEW

**FIGURE 34**

The *View* menu selections toggle different *Virtual Set Canvas* guides on and off, as described below.

- The 16:9 and 4:3 *Safe Area* guides make it easy to see what parts of the overall canvas will appear in the frame on corresponding HD and SD devices. The inner rectangle represents a *Safe Text* guide, while the outer one marks a *Safe Action* area.
- The *Center Cross* divides the screen into quadrants, and makes it easy to ensure you have things properly aligned on the X and Y axes.

---

### 3.2.3 HELP

- Selecting *View Help* allows you to view the manual.
- Select *About* displays various details related to VSE, including version details and credits.
- Finally, use the *Check for Updates* item (when connected to the Internet) to ensure you are running the latest release of the software.

---

### SECTION 3.3 ANGLE BIN

**FIGURE 35**

Many presets offer more than one camera angle on a virtual set, and you can modify any or all of them at will. To switch to a different angle, simply highlight its icon in the *Angles Bin* by clicking it. The corresponding view will appear on the *Canvas*, ready for you to edit its attributes.
To rename an angle, right-click its icon in the bin, and select Rename (Figure 36).

SECTION 3.4 CONTROL STACK

The Control Stack contains nested controls for different set elements that can be modified, or even disabled. Even so, it's quite easy to use, as similar attributes present similar controls in the various sets. We'll consider the way these work, and leave the creativity to you.

Let's take a closer, using a typical example – the Monitor group from the City Loft set preset.

3.4.1 ITEM HEADERS

Initially, all we see of the Monitor control group is its collapsed header (Figure 37). As you know, you can expand this by clicking the triangle gadget at left, which twirls downward and reveals the nested controls when you do so. You may find it even faster to simply double-click the group header. Like the triangle gadget, this expands or contracts the group.

Additionally, take note of the bright checkmark at the extreme right end of item headers. As we saw back in the Walkthrough Chapter, clicking the checkmark toggles the item (or group) on or off, indicating that the feature is either enabled or disabled.

Hint: You’ll recall that group headers highlight as you roll the cursor over them, and that the corresponding feature will also highlight on the Canvas as you do so. Some local items nested within a control group also provide this handy behavior.

SOURCE MENU

When the group is expanded, we see that its first option is labeled Source. Clicking the currently assigned source (in this case, Input B), reveals a drop-down menu that allows you to specify a different source to display on the monitor. Typically, monitors in virtual sets really are used to display a video source, and you can select a specific input here.
Note: The inputs shown in the list vary – some live production suite installations will list just two inputs as available (A and B), while others show four, as appropriate for the model.

Standalone installations show four available inputs. However, when exported LiveSets are used on live production suites that do not support four LiveSet inputs, only A or B selections will work as expected.

The Opacity slider defaults to 100%, or fully opaque. Reducing the value makes the object increasingly transparent. Observe also the Keyable switch. This is an important option. When enabled, Keyable tells the live production system you wish the operator to be able to applying LiveMatte (chromakeying) to the input.

Selecting Browse opens NewTek’s custom Media Browser, which allows you to select an image from any existing live production suite session, including ‘grabs’ from live video, imported images and graphics, user-added Locations, and so on.

The Recent menu point allows you to quickly re-locate an image file from among those you have selected recently.

3.4.2 POSITION, SCALE, AND ROTATION

Next we see a Position control group, with Position, Rotation and Scale sections, respectively.

- Click and drag on the Position button (identified by a double-headed arrow) to relocate the assigned source vertically or horizontally within its frame on the Canvas.
- By dragging left or right on the X and Y numeric sliders at right, you can adjust the position on a single axis at a time.
- Alternatively, you can constrain the action to one axis when dragging on the double-headed arrow button by holding down the Ctrl key before dragging.

Hint: If you click a numeric field (or right-click it), you can type a value into the field using the keyboard – press Enter to complete the editing action, or Esc to cancel it.

Dragging the cursor on the Scale button (magnifying glass) affects the scale of the overlay.
• When the nearby lock button is enabled, dragging in any direction affects size equally on both axes.
• Otherwise, dragging vertically changes the height of the overlay, and dragging horizontally affects its width.
• Again, drag just one of the numeric gadgets next to the Scale button (with lock disabled) or hold down Ctrl when dragging over Scale to independently modify just one dimension of the item (width or height).

In similar fashion, drag the pointer over the Rotation button with the left mouse button pressed to turn the overlay source in 3D space, as follows:

• Drag left/right to rotate the source about the Y (vertical) axis.
• Drag up/down to rotate the source about the X (horizontal) axis.
• Drag up/down while holding down the right mouse button to rotate about the Z axis.
• Drag on a single numeric slider at right, or hold down Ctrl while dragging to constrain rotation to one axis.

Position, Rotation and Scale can be reset by clicking Reset Positioning.

Hint: Reset most controls to their default value by holding down Shift while double-clicking it.

3.4.3 PROC AMP

Brightness, Hue, Contrast and Saturation controls are familiar from live production suite’s Live Desktop, where they are located in the Proc Amp controls for inputs.

• Brightness: Adjustment range from -100 to +100% (the default being 0).
• Contrast – Adjustment range from 0 - 500% (default 100%).

• Hue – Adjustment range from -180° to +180°. Adjusts the master color of the selected Source, swinging the entire image through the color wheel’s spectrum.

• Saturation – Adjustment range from 0-500%. Zero saturation results in a ‘black and white’ picture; increased saturation results in richer colors. High saturation values can exaggerate the color portion of the signal. Note that over-saturated colors are considered illegal for broadcast transmission, and may result in display problems on some devices.

(The result of clicking Reset Color will come as no great surprise, so perhaps we’ll leave that as a student exercise.)
3.4.4 STYLE

A Style menu doesn't appear in the Monitors group, but we should give it a moment's attention as well. Expand the Input A control group to show it. Style is a bit of a joker, since it may govern different features in various places.

One very useful thing it offers in some instances is that it permits you to select between a one-person or a two-person frame overlay on the Virtual Set Canvas. Elsewhere, it may be used to provide other options, such as enabling or disabling lighting effect. Be sure to check it out wherever it appears.

SECTION 3.5 ANIMATION CONTROLS

We reviewed the use of the Animation Controls (Figure 41) in the Walkthrough Chapter. The thumbnail icon shows the active zoom/pan preset position, which is also a) seen on the Canvas and b), highlighted with a blue border in the Shot selector that opens when you click the thumbnail icon.

![Figure 41](image)

Edits made to the composition of the current preset take effect immediately. Clicking a different thumbnail in the Shot selector begins an animated zoom preview right on the Canvas.

Notice, too, that you can right-click a Shot menu thumbnail to open a context menu offering Copy and Paste features. This makes it a simple matter to duplicate a shot, and then tweak the new iteration to taste.

Note: The first and last presets serve as Start and End (min and max zoom) positions for live production suite models that do not support all nine preset shots.

SECTION 3.6 VIRTUAL SET CANVAS

The large Virtual Set Canvas dominates the screen. It not only provides feedback on your work in progress, but also supports certain editing operations, and even allows you to preview animated zooms.

In addition, as previously mentioned, various objects on the Canvas may be highlighted when you roll the mouse cursor over their respective headers in the Control Stack.
The Canvas allows you to interactively adjust the zoom level and center frame point for the Start and End positions.

When zoomed out to the maximum level for the set, dragging the cursor on the screen has no effect. As soon as you have zoomed in a bit, though, you can drag left, right, up or down to re-center the frame – in essence relocating its target point.

There are several ways to zoom in and out and pan on the Canvas:

- Hold down the right mouse button, and drag up or down.
- If you mouse has a scroll-wheel, rotate it to zoom in and out.
- Press Ctrl with the + or – keys (top row plus and minus sign).
- Hold down the Alt key, and drag up or down.

---

**SECTION 3.7 IMPORTING PHOTOSHOP® FILES**

As mentioned earlier, Virtual Set Editor can also import PSD files from the Startup Wizard or File>Open, and create LiveSets from them. This is extremely useful, since it permits users to prepare layered files for conversion to LiveSets using familiar 2D art software.
Note that the order of layers in the Control Stack for PSD files you import is inverted compared to the original – so, for example, the Background layer is at the bottom of the Layer Panel in Figure 44, but will appear at the top of VSE’s Control Stack after import.

3.7.1 FILE REQUIREMENTS

There are a few things to know about working with PSD files in VSE. Generally, all layers in the file should be rasterized (i.e., bitmap layers, not employing transfer modes, etc.). Also, images should be RGB Color Mode (not CMYK, etc.).

3.7.2 INPUT LAYERS

For VSE purposes, image layers in the PSD file serve one of two purposes. Either a layer contains graphic imagery that will be part of the composite result, or it is an “Input Layer”. Input layers are replaced by the video sources assigned in live production suite’s Virtual Input tab in the finished LiveSet. VSE identifies input layers in imported PSD files by their layer name. You can use the name to identify the layer as a proxy for Inputs A-D.

A layer with any of the following names will be replaced by Input A: "Input A", "InputA", or their lower case equivalents. When the PSD file is imported, input layers are listed in VSE’s Control Stack as “Input Layer 0”, “Input Layer 1”, and so on. It’s also possible to assign a custom name to a video input layer when creating VSE projects from Photoshop® files. Simply assign the layer a name as shown on the lines below:

Input A name = “Stand-up Talent”

or, as another example: Input B name = “PiP”
Add the word “keyable” to a video input layer in a PSD file to enable the *Keyable* switch on import into VSE. (Failure to use this keyword simply means the layer won’t *initially* have *Keyable* checked; it does not prevent you from changing the switch setting later in VSE.) Consider some layer name examples:

- Input A Keyable
- input b name = "Talent" Keyable
- input d keyAble name="No Talent"

*Note:* The "Input x" designation must come first on any input layer. Modifiers such as a custom name or "keyable" can come in any order after that.

---

**LAYER GROUPS**

On conversion, Photoshop® image layers that are nested inside groups will be organized into similar groups under headers in VSE’s *Control Stack*. This is a useful way to make it easier to manipulate VSE layers.

---

**MULTI-ANGLE LIVESETS**

Specially named groups (folders) in Photoshop® PSD files can be used to create VSE projects with multiple angles. Let’s consider an example. Suppose your PSD file contains a group named as follows:

- Angle="Left"

On import into VSE, you will see an angle named “Left” in the *Angles Bin*, and its *Control Stack* content will reflect the layer structure of the group. Optionally, append the keyword “default” to the group name to make this the default angle when the project is loaded into VSE. For example:

- Angle="Center" Default

It is possible to use a single group to provide layers for more than one virtual set angle. For example, if the angle name is set to “left, right”, or “left, center, standing”, the group will supply content to all of the named angles on import. Similarly, if a PSD file includes both individual layers along with angle groups, the ungrouped layers will appear in every angle of the VSE project.

*Note:* Nesting angle groups inside other groups is not recommended, and may result in missing layers.

Finally, it’s worth noting that angle group names can also be used more than once in a PSD file (i.e., two or more groups can share the same name). ‘Same name’ groups will be treated as though they were a single, merged group, and will result in a single angle in the VSE project after importing.

---

**DISTORTION AND WARping**

*If you have a recent version of Photoshop® that supports input and output of high dynamic range imagery, more elaborate transformations or distortions are possible (Figure 45).*
You will find a file named "VSE UV Gradient.exr supplied in your VSE installation folder (specifically, in the folder C:\Program Files\NewTek...\AddOns\Virtual Set Editor\Extras (or for standalone versions, look in C:\Users\Public\Documents\NewTek Content\Stills\Virtual Set Editor). This special image is a UV gradient in the form of an OpenEXR file. It is intended to serve as a proxy video input layer proxy in your Photoshop® project when you need more powerful input layer transformations.

The Photoshop project should be 16 bit color depth (32 bit files can result in gamma issues) before loading the .exr file. Save the final layered PSD in the same color depth, too, to preserve any transformations or distortions accurately.

Note that with one exception, you must use the (.exr) proxy gradient for all video input layers in the project in this case: completely empty (transparent) layers will be treated as a full-frame video input layer.

Hint: When you do not require advanced transformations, 8bit color depth is fine for both project and file exports. Only the opacity in input layers is recognized by VSE in this case; color information is ignored.

REFLECTIONS

In somewhat similar fashion, 'reflections' of live video in a LiveSet are created using a suitably modified gradient layer.

You can use a simple 2D graphics application to produce a gradient layer having the appropriate size, shape, orientation and distortion for the reflection; or you might pull a reflection buffer image from a 3D application (i.e., an image containing just surface reflections from the polygon you mapped the video input gradient texture to, and no other opacity).

Rather than reducing the opacity of this reflection layer (in the layered PSD file, or using VSE) to control the apparent amount of reflection in the result, it is necessary to add a partially opaque layer above it. For example, to add a reflection to a desk top, you might arrange layers as follows (listed from 'front' to 'back' from the viewer's perspective):

a) Partially transparent matte
b) Reflection layer
c) Desk Layer
d) Video input layer
e) Background layer

'Layer a' in this example is essentially a segment from a render of set elements appearing in front of the video input polygon, without the reflection. Reduce the opacity of selected portions of 'layer a' so that the color of the reflection layer (b) below shows through in a suitable amount to mimic reflection.

The file Advanced Desk.psd in the "Example PSDs" folder can serve as a reference to how to prepare the layers for this type of scene.
INPUT LAYERS, PROXIES, AND OPACITY

In the assumption that Input A is most often used for greenscreen shots, imported Input A layers display the ‘phantom’ One Person proxy on the Canvas by default (and in the icon for the resulting LiveSet). You can select a different proxy image for the layer from the Style menu if you wish.

As mentioned earlier, VSE infers a full screen input when an input layer is completely empty. Otherwise, opaque pixels are replaced by input source pixels in one manner or another.

Support for 16 bit PSD files was added in version 2 to support distortion and warping, as discussed previously. In these high dynamic range files, replacement of layer pixels by input pixels in the final LiveSet is always governed by the UV color values for each pixel in the input layer.

Also as explained in the previous section, however, pixel colors in input layers of 8bit files are irrelevant. Only pixel opacity is important to VSE in this case. (You can still achieve perspective effects with 8 bit PSDs by using VSE’s Position and Scale tools.)

KEYING

If the Keyable switch is set in VSE for an input source, when the resulting LiveSet is displayed in the live production suite’s Live Desktop, the background behind it in the LiveSet will be seen (Figure 47) when LiveMatte is correctly configured and applied.

The video source will obscure the background when LiveMatte is disabled, just as you would expect.

Important Note:

If your design calls for two video inputs in your project to overlap, special care must be taken to avoid distortion and other problems in the final LiveSet. Really it’s best to avoid the potential problem altogether, whether by techniques like cropping and positioning of input layer content, or perhaps by adding elements like monitor ‘bezels’, etc. to the set design to create adequate separation. In any case, you must ensure that two ‘same type’ input layers never overlap. (‘Same type’ input layers are defined as those tagged as a) ‘keyable’, or b) not marked ‘keyable’.)

This may require more separation than you’d expect, since antialiasing often causes hard-to-detect blending of what may seem to be merely ‘neighboring’ pixels. In general, if an input layer must overlap another, best practice calls for marking the foremost one as keyable, and the input layer behind it as non-keyable.
SECTION 3.8 HOLOGRAPHIC LIVESETS

FIGURE 48

A Holographic LiveSet™ differs from other LiveSets LiveSet in that, rather than adjusting the virtual camera position horizontally and vertically across stage having a certain fixed 'width', you rotate and zoom a fixed virtual camera in a curved panorama (right up to 360 degrees).

Virtual Set Editor can use either spherical or cylindrical panoramic projections. The source panoramic images can be acquired from any number of sources, including photos prepared using standard iPhone® camera features, software ‘photo-stitching’ applications such as Microsoft’s Image Composite Editor® (free at the time of writing), or even a render from 3D graphics software like NewTek’s own LightWave® (http://www.lightwave3d.com).

FIGURE 49

VSE can map as many as four independent live video sources into the scene prepared from the panoramic image you supply. These live video sources can be scaled and positioned anywhere within the virtual environment.
You can even make video sources appear to pass behind elements in the image, using mask images to lock portions of the scene so video doesn’t appear there (Figure 49).

3.8.1 PANORAMIC BACKGROUND IMAGES

The first requirement when creating a panoramic set is to acquire a panoramic image to serve as the Holographic LiveSet background. Several sample panoramic images, along with the source photos used to generate them are provided.

Of course, you will inevitably want to create brand new LiveSets from your own imagery. Fortunately, what was a difficult, time-consuming technical process just a few years ago is now simple and easy, even using free software tools that anyone can access.

As mentioned earlier, two of the better known tools to generate these images are the ‘Panoramic’ mode built in to the iPhone’s camera (iOS6 or higher), and Microsoft’s free panoramic image stitching software, called Image Composite Editor (http://research.microsoft.com/en-us/um/redmond/groups/ivm/ice/).

**Hint:** These are just two examples. A quick search for terms like “photo stitching software” or “panoramic photo software” will turn up many interesting alternatives for a number of platforms.

The two most common panoramic formats involve imagery mapped to either a sphere or a cylinder shape. VSE can work with either type, as follows:

1. Launch VSE
2. Create a new panoramic VSE project by any of the following means (the result is the same no matter which method you use):

   ![New Project](image)

   **FIGURE 50**

3. Using the *Startup Wizard*, select the “From Panorama” icon in the *New Project bin*. (Alternatively, if LiveSet is already open to a project, select Open in the *File* menu to open the *Startup Wizard*.)

   **Hint:** There is yet another approach. Selecting New from the *File* menu opens VSE in its default project format, which shows a stand-in holographic canvas. You can also begin creating a Holographic LiveSet in this manner, and then load the panoramic background image using the Source drop-down menu found under the Background group header in the Control Stack.
4. At this point, you need to select a file to serve as the panoramic background.

Hint: Several sample images are supplied with VSE. You will find these in folders named City Hall (Figure 51) and Downtown Church in the directory at C:\Program Files\NewTek\...\Effects\LiveSets\Templates.

Once the panoramic background image file loads, VSE’s virtual set canvas updates.

You will find that mouse operations on the canvas have a slightly different outcome now. The mouse-wheel still serves to zoom in and out, but dragging the mouse pointer rotates the virtual camera on its axis, rather than moving it laterally or vertically.

5. Depending on the source type, choose Spherical or Cylindrical mapping in the Camera controls group (Figure 52).

6. Notice that VSE attempts to detect and configure horizontal and vertical rotational limits under the heading Camera and Field of View. To set vertical values manually, turn off the nearby Auto switch.
7. Expand the *Input 1* control group, and use the position tools to relocate the assigned video source (Input A, by default) to taste. VSE does a creditable job of keeping the source properly oriented as you do so.

8. The Source control group also lets you choose a Mask image. Figure 54 shows a cropped version of the mask image supplied for use with the City Hall panorama. It corresponds precisely to the railing at the City Hall’s front door. Video source imagery will not appear in the LiveSet where the mask pixels are black (use the *Invert* switch to reverse the masking effect).

The rest of the process is really identical to the preparation of a standard LiveSet. Assign, align and adjust your Input Sources, create individual preset positions for the camera, then finish up by saving your work and exporting the finished Holographic LiveSet.

**SECTION 3.9 FLARES**

Being able to add lens flares lends one more level of reality to a LiveSet. The following shows how to add them and what controls you have available.

Located to the right of the Scene tab is Flares. Your initial option is to click “Add... “, this will invoke the Media Browser where you can select a flare to add to the LiveSet.
After a flare has been added to the LiveSet you will have access to a handful of controls:

- **Position**- Allows you to translate the flare anywhere within the LiveSet. This can be achieved by directly adjusting the values of the X and Y axis, or using the cross-hair tool to freely move along both axis.
- **Brightness**- The brightness of the flare can be adjusted between 0 and 100%.
- **Scale**- The scale (or size) of the flare can be adjusted up to 300%. This setting may not have much effect if the brightness is set too low or at 0%.
- **Fade Off Screen**- can be used to set how visible the effect of a flare is when it has moved off screen.
- **Masked by Video**- A toggle.

Clicking on the name of a flare will present a dropdown menu that contains the following:

- **Reset**- Use this to return all the settings to their default values.
- **Browse**- Opens the media browser so you can select a different flare.
- **Recent**- Provides a listing of flares you have loaded recently.
A flare menu can be collapsed in the sidebar, this is useful if you are using more than one flare. These header bars also allow you to hide or even delete a flare from the project.

Right-clicking on a flare in the menu provides the following options:

- **Clone** - Creates a copy of the selected flare.
- **Remove** - Deletes the selected flare from the menu.
- **Rename** - Allows you to rename the selected flare.
PART III (APPENDICES)

A time-saving question and answer section, followed by an extensive listing of Shortcut Keys, schematic diagram and keyword index ...
In this section, we’ll consider the most common questions Virtual Set Editor users may have (and of course we’ll provide the answer, too).

The answers are intentionally brief – perhaps just a reminder of one or two steps required to perform some operation. For this reason, we’ll also point you to explanatory information elsewhere in this manual whenever that would be useful.

If you’ve largely mastered your VSE but have a specific question, this may be the best place to look first. The headings that follow list related questions and answers together, along with cross-references and other helpful remarks.

Hint: The NewTek website includes a comprehensive FAQ database containing a wealth of useful information on all of its products – please see http://www.newtek.com/faq/

How do I ...

**VIRTUAL SETS**

<table>
<thead>
<tr>
<th>Question</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADD MORE VIRTUAL SET PRESETS?</td>
<td>47</td>
</tr>
<tr>
<td>CREATE A COMPLETELY CUSTOM VIRTUAL SET?</td>
<td>47</td>
</tr>
</tbody>
</table>

**FILE MANAGEMENT**

<table>
<thead>
<tr>
<th>Question</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOCATE MY NEW VIRTUAL SETS IN THE LIVE PRODUCTION SUITE’S LIVE DESKTOP?</td>
<td>48</td>
</tr>
<tr>
<td>ORGANIZE VIRTUAL SETS IN CUSTOM LOCATIONS?</td>
<td>48</td>
</tr>
<tr>
<td>USE THE ADVANCED EDITION STYLE FILE NAMING SCHEME?</td>
<td>48</td>
</tr>
</tbody>
</table>

| Question                                                                 | Page |
| DELETE UNWANTED VIRTUAL SETS?                                            | 49   |

A.1 VIRTUAL SETS

**A.1.1 ADD MORE VIRTUAL SET PRESETS?**

NewTek may offer optional content packs with more virtual set presets from time to time. The new presets will be installed to the correct location in your live production suite automatically.

**A.1.2 CREATE A COMPLETELY CUSTOM VIRTUAL SET?**

VSE’s primary purpose is to allow live production suite users to *easily* customize LiveSets to their local need. In addition, it allows users to create completely original virtual sets by importing layered Adobe® Photoshop® PSD files or panoramic images (see Section 3.7 and Section 3.8).

Beyond this, it is not anticipated that most users will wish to pursue custom LiveSet authoring. In some cases, users may utilize specialist services offered by various third-party developers rather than endeavoring to master the skills (and tools) required.
A.2 FILE MANAGEMENT

A.2.1 LOCATE MY NEW VIRTUAL SETS IN THE LIVE PRODUCTION SUITE’S LIVE DESKTOP?

1. When you perform an export operation, the newly created virtual set is stored in the User folder at the default LiveSet effects location on the system.
2. Open a live production suite session, and click a Virtual Input tab.
3. Click the Add button in the Virtual Input tab, to show the Media Browser.
4. You will see a User sub-heading listed (along with NewTek) under the LiveSets header in the Location List at left in the Media Browser.
5. Click the User location entry and icons for your new LiveSets will be shown in the File Pane at right.

A.2.2 ORGANIZE VIRTUAL SETS IN CUSTOM LOCATIONS?

1. To move your virtual sets to custom locations, select the Shutdown icon on the Home Page of the live production suite’s Startup Screen, select Exit to Windows, and confirm this decision.
2. Navigate from the Windows Desktop to C:\Program Files\NewTek...\Effect\LiveSets.
3. Create a new sub-folder with the custom name you wish to appear alongside NewTek and User in the Media Browser Location List (under the LiveSets header).
4. Drag the folder(s) for the LiveSet you wish to appear in the custom location into the new folder you created earlier.
5. Then simply re-launch the live production suite, and re-open your session. The newly created folder will appear as a sub-heading in the Media Browser’s Locations List, and its content will be displayed in the File Pane at right when you select it.

A.2.3 USE THE ADVANCED EDITION STYLE “BASIC/STANDARD” FILE NAMING SCHEME?

NewTek’s live production suite displays LiveSet names and the name of specific shots (or “angles”) in several places in the interface. Prior to Advanced Edition, the folder and file names supplied this information. In Advanced Edition, however, many virtual sets are supplied in both Standard (i.e., with lens flares) and Basic (no lens flares) versions. To accommodate folder structure changes that distinguish the two versions, an alternative method of embedding set and shot names was implemented.

Since your sets will not normally use this new folder structure, Virtual Set Editor does not automatically enforce this new naming method. However, you may find it useful when your requirements involve a custom folder structure.

Each compiled LiveSet is defined by an xml file with the file extension “liveset”. In these files, an “info type” tag identifies the LiveSet version used. Two new keys have been added to this tag to allow file and shot names to be stored without any reference to the external folder structure used.

Specifically, note the example tag below, which describes the “Center” shot for a set named “Night Beat”:

<info type="LiveSet3" set_name="Night Beat" shot_name="Center"/>

The live production suite will use names supplied in this file in preference to the standard (folder-filename) method when identifying LiveSets.
A.2.4 DELETE UNWANTED VIRTUAL SETS FROM THE LIVE PRODUCTION SUITE?

1. You may create some virtual sets that, for one reason or another, are not 'keepers'. To remove them from the live production suite entirely, select the Shutdown icon on the Home page of the live production suite’s Startup Screen, select Exit to Windows, and confirm this decision.

2. Navigate from the Windows Desktop to C:\Program Files\NewTek\..\Effect\LiveSets.

3. Locate the folder for the LiveSet you wish to delete, then simply right-click on it and select Delete from the context menu.

4. Re-launch the live production suite.
# B KEYSTROKE SHORTCUTS

## B.1 MENU OPERATIONS

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Ctrl + n</td>
</tr>
<tr>
<td>Open</td>
<td>Ctrl + o</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl + s</td>
</tr>
<tr>
<td>Save As</td>
<td>Ctrl + S (Shift + s)</td>
</tr>
<tr>
<td>Close</td>
<td>Alt + F4</td>
</tr>
<tr>
<td>Help</td>
<td>F1</td>
</tr>
</tbody>
</table>

## B.2 VIRTUAL SET CANVAS

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td>Ctrl + (plus sign)</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Ctrl + (minus sign)</td>
</tr>
<tr>
<td>Drag to zoom</td>
<td>Alt + drag mouse up/down</td>
</tr>
<tr>
<td>Constrain dragging (panning)</td>
<td>Hold Shift before dragging</td>
</tr>
</tbody>
</table>

## B.3 CONTROL STACK

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset control to default value</td>
<td>Shift + double-click</td>
</tr>
<tr>
<td>Constrain drag operation (pan/scale direction, rotation axis)</td>
<td>Hold Ctrl before dragging</td>
</tr>
</tbody>
</table>

## B.4 ANIMATION CONTROL

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jump to current Start preset position</td>
<td>Home</td>
</tr>
<tr>
<td>Jump to current End preset position</td>
<td>End</td>
</tr>
</tbody>
</table>
A
Add-Ons, 10
Adobe® Photoshop® Files, 33, 47
Advanced Edition
File Names, 48
Lens Flares, 41
Angle Bin, 28
Angle, rename, 29
Angles Bin, 15
Animation Controls, 15, 19, 32

B
Browse, 17, 30

C
Canvas, 19, 32
Check for Updates, 28
Control Stack, 15, 17, 29, 34
Headers, 29
Hinting, 18
Source, 29
Distortion, 35

D
Import Files, 33, 47
Input Layer, 34
Installation, 8

E

F
File, 26
Open, 21
Recent, 27
Save As, 20
Help
Check for Updates, 28
View, 20, 28

P
Photoshop® Files, 33, 47
Position, 30
Preset, 14, 25
Proc Amp, 30
PSD Files, 33, 47

R
Reflections, 36
Registration, 10
Rename Angle, 29
Rotation, 30

S
Safe Area, 20, 28
Scale, 30
Startup Wizard, 13, 25
Style, 32

U
Updates, 28

V
Video Input Layer, 34
Virtual Set Canvas, 19, 32
VSE Desktop, 14, 26

W
Warping, 35

Z
Zoom Presets, 15, 20, 33
Zooming, 20, 32, 33
Acknowledgments: Tim Jenison, Jim Plant


Design Consultants: Kris Gurrad

Additional thanks to:
- NewTek Marketing and Sales
- NewTek Customer Support
- NewTek Business Development

This product uses the following libraries, licensed under the LGPL license (see link below). For the source, and the ability to change and recompile these components, please visit the links provided:

- FreeImage library http://freeimage.sourceforge.net/
- LAME library http://lame.sourceforge.net/
- FFmpeg library http://ffmpeg.org/

For a copy of the LGPL licence, please look in the folder c:\TriCaster\LGPL\n
Portions use Microsoft Windows Media Technologies. Copyright (c)1999-2008 Microsoft Corporation. All Rights reserved.

VST PlugIn Spec. by Steinberg Media Technologies GmbH.

All other software with the TriCaster not expressly noted as free is proprietary and subject to NewTek's copyright rights or those of its licensors.

Trademarks: NewTek, TriCaster, TriCaster XD, TriCaster 8000, TriCaster TCXD8000, TCXD8000, TriCaster 860, TriCaster TCXD860, TCXD860, TriCaster 460, TriCaster TCXD460, TCXD460, TriCaster 410, TriCaster TCXD410, TCXD410, TriCaster Mini, TriCaster 40, TriCaster TCXD40, TCXD40, TriCaster 855, TriCaster TCXD855, TCXD855, TriCaster 455, TriCaster TCXD455, TCXD455, TriCaster EXTREME, TriCaster 850 EXTREME, TriCaster TCXD850 EXTREME, TCXD850 EXTREME, TriCaster 450 EXTREME, TriCaster TCXD450 EXTREME, TCXD450 EXTREME, TriCaster 850, TriCaster TCXD850, TCXD850, TriCaster 450, TriCaster TCXD450, TCXD450, TriCaster 300, TriCaster TCXD300, TCXD300, TriCaster PRO, TriCaster STUDIO, TriCaster BROADCAST, TriCaster DUO, 3PLAY, 3Play, 3Play 4800, 3PX4800, 3Play 440, 3PX440, 3Play 820, 3PX820, 3Play 425, 3PX425 3Play 330, 3PX330, TalkShow, TalkShow VS100, ProTek, ProTek Care, ProTek Elite, iVGA, SpeedEDIT, IsoCorder, LiveText, DataLink, LiveSet, TriCaster Virtual Set Editor, TriCaster VSE, LiveMatte, TimeWarp, VT, VT[3], VT[4], V[T5], Video Toaster, Toaster, Inspire 3D, 3D Arsenal, Aura, LightWave, LightWave 3D and LightWave CORE are trademarks, service marks, and registered trademarks of NewTek. All other brand names, product names, or trademarks belong to their respective holders.

(c) NewTek 2005-2016, All Rights Reserved